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Each lesson has its own 
folder inside the Lessons 
folder. You will need to copy 
these lesson folders to your 
hard drive before you can 
begin each lesson.

Lesson files

The Adobe® Premiere® Elements 10 Classroom in a Book® disc includes the lesson 
files that you’ll need to complete the exercises in this book, as well as other content 
to help you learn more about Adobe Premiere Elements 10 and use it with greater 
efficiency and ease. 

What’s on the DIsC
here is an overview of the contents of the Classroom in a Book disc.

online resources

adobe Press

Links to Adobe Community 
Help, product Help and 
Support pages, Adobe cer-
tification programs, Adobe 
TV, and other useful online 
resources can be found 
inside a handy HTML file. Just 
open it in your Web browser 
and click on the links, includ-
ing a special link to this 
book’s product page where 
you can access updates and 
bonus material.
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Adobe Premiere Elements 10 delivers video-editing tools that balance power 
and versatility with ease of use. Premiere Elements 10 is ideal for home users, 
hobbyists, business users, and professional videographers—anyone who wants 
to produce high-quality movies and DVDs.

If you’ve used earlier versions of Premiere Elements, you’ll find that this 
Classroom in a Book covers the many new advanced skills and innovative fea-
tures that Adobe Systems introduces in this version. If you’re new to Premiere 
Elements, you’ll learn the fundamental concepts and techniques that will help 
you master this application.

about Classroom in a Book
Adobe Premiere Elements 10 Classroom in a Book is part of the official training 
series for Adobe graphics and publishing software developed by Adobe prod-
uct experts. Most lessons in this book include self-paced projects that give you 
hands-on experience using Premiere Elements 10.

The Adobe Premiere Elements 10 Classroom in a Book includes a DVD 
attached to the inside back cover. On the DVD, you’ll find all the files used for 
the lessons in this book. As an overview, in the first two lessons, you’ll learn 
your way around Premiere Elements’ interface, how to set up a project, and 
how to customize critical preferences. 

In Lesson 3, you’ll learn how to capture and otherwise import video into 
Premiere Elements. Starting with Lesson 4 and continuing through Lesson 13, 
you’ll open projects on the DVD or create your own from contents on the disc, 
and learn how to convert your raw, captured clips into a polished movie. 

GettInG starteD



2 Getting started

Prerequisites
Before you begin working on the lessons in this book, make sure that you and your 
computer are ready.

requirements for your Computer
You’ll need about 4.3 gigabytes (GB) of free space on your hard drive for the lesson 
files and the work files you’ll create. For some lessons, you will need to have 2 GB 
of RAM installed on your computer. Note that the lessons assume that you have 
installed all templates and associated content available with the DVD version of 
Premiere Elements 10. If you see a template that’s not installed on your computer, 
you should be able to simply choose another template and continue with the lesson. 

required skills
The lessons in this Adobe Premiere Elements 10 Classroom in a Book assume that 
you have a working knowledge of your computer and its operating system. This 
book does not teach the most basic and generic computer skills. If you can answer 
yes to the following questions, you’re probably well qualified to start working on the 
projects in these lessons. You will almost certainly get the most benefit from work-
ing on the lessons in the order in which they occur in the book.

• Do you know how to use the Microsoft Windows Start button and the Windows 
task bar? On the Mac, do you know how to run applications from the Dock or 
in the Applications folder? In both operating systems, can you open menus and 
submenus, and choose items from those menus?

• Do you know how to use My Computer, Windows Explorer, Finder, and/or 
a browser such as Internet Explorer or Safari to find items stored in folders 
on your computer, or to browse the Internet? 

• Are you comfortable using the mouse to move the pointer, select items, drag, 
and deselect? Have you used context menus, which open when you right-click 
items in Windows or Control-click items on the Mac if you’re working with a 
single-button mouse?

• When you have two or more open applications, do you know how to switch 
from one to another? Do you know how to switch to the Windows or 
Macintosh desktop?

• Do you know how to open, close, and minimize individual windows? Can you 
move them to different locations on your screen? Can you resize a window 
by dragging?

• Can you scroll (vertically and horizontally) within a window to see contents that 
may not be visible in the displayed area?
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• Are you familiar with the menus across the top of an application and how to use 
those menus? 

• Have you used dialogs (special windows in the interface that display 
information), such as the Print dialog? Do you know how to click arrow icons 
to open a menu within a dialog?

• Can you open, save, and close a file? Are you familiar with word-processing 
tasks, such as typing, selecting words, backspacing, deleting, copying, pasting, 
and changing text?

• Do you know how to open and find information in Microsoft Windows or 
Apple Macintosh Help?

If there are gaps in your mastery of these skills, see the documentation for your 
operating system. Or, ask a computer-savvy friend or instructor for help.

Installing Premiere elements 10
Premiere Elements 10 software (sold separately) is intended for installation on a 
computer running Windows XP, Vista, or Windows 7, or Mac OS 10.5x or later. For 
system requirements and complete instructions on installing the software, see the 
Premiere Elements 10 application DVD and documentation. To get the most from 
the projects in this book, you should install all the templates included with the 
software. Otherwise, you may notice “missing file” error messages.

Copying the Classroom in a Book files
The DVD attached to the inside back cover of this book includes a Lesson Files 
folder containing all the electronic files for the lessons in this book. Follow the 
instructions to copy the files from the DVD, and then keep all the lesson files on 
your computer until after you have finished all the lessons.

Copying the Lessons files from the DVD
1 Insert the Adobe Premiere Elements 10 Classroom in a Book DVD into your 

DVD-ROM drive. Open the DVD in My Computer or Windows Explorer 
(Windows), or in the Finder (Mac OS).

2 Locate the Lesson Files folder in the Premiere Elements 10 folder on the DVD, 
and copy it to any convenient folder on your computer. Just remember where 
you copied it, because you’ll be opening the lesson files frequently throughout 
the book. In the Lesson Files folder, you will find individual folders containing 
project files needed for the completion of each lesson.

 Note: The videos 
on the DVD are practice 
files provided for your 
personal use in these 
lessons. You are not 
authorized to use these 
videos commercially 
or to publish or 
distribute them in any 
form without written 
permission from Adobe 
Systems Incorporated, or 
other copyright holders.



4 Getting started

3 When your computer finishes copying the Lesson Files folder (which could take 
several minutes), remove the DVD from your DVD-ROM drive, and store it in 
a safe place for future use. 

additional resources
Adobe Premiere Elements 10 Classroom in a Book is not meant to replace docu-
mentation that comes with the program, nor is it designed to be a comprehensive 
reference for every feature in Premiere Elements 10. Only the commands and 
options used in the lessons are explained in this book. For comprehensive informa-
tion and tutorials about program features, please refer to the following resources.

Adobe Community Help: Community Help brings together active Adobe product 
users, Adobe product team members, authors, and experts to give you the most 
useful, relevant, and up-to-date information about Adobe products. Whether 
you’re looking for an answer to a problem, have a question about the software, 
or want to share a useful tip or technique, you’ll benefit from Community Help. 
Search results will show you not only content from Adobe, but also from the com-
munity. With Adobe Community Help you can:

• Access up-to-date definitive reference content online and offline

• Find the most relevant content contributed by experts from the Adobe 
community, on and off Adobe.com

• Comment on, rate, and contribute to content in the Adobe community

• Download Help content directly to your desktop for offline use

• Find related content with dynamic search and navigation tools

To access Community Help: The Community Help application downloads when 
you first install Premiere Elements 10. To invoke Help, press F1 or choose Help > 
Premiere Elements Help. 

To ensure that you have the latest version of the Community Help application, 
download it from www.adobe.com/support/chc/index.html.

Adobe content is updated based on community feedback and contributions. 
You can contribute in several ways: You can add comments to both content and 
forums—including links to web content, or publish your own content using the 
Community Publishing AIR app. You’ll find more information about how to con-
tribute at www.adobe.com/community/publishing/download.html.

See http://community.adobe.com/help/profile/faq.html for answers to frequently 
asked questions about Community Help.

www.adobe.com/support/chc/index.html
www.adobe.com/community/publishing/download.html
http://community.adobe.com/help/profile/faq.html


Adobe Premiere elements 10 ClAssroom in A book 5

Adobe Premiere Elements 10 Help and Support: Point your browser to  
www.adobe.com/support/premiereelements where you can find and browse 
Help and Support content on adobe.com.

Adobe TV: At http://tv.adobe.com, you’ll find an online video resource for expert 
instruction and inspiration about Adobe products, including a How To channel to 
get you started with your product.

Resources for educators: The website www.adobe.com/education includes three 
free curriculums that use an integrated approach to teaching Adobe software and 
can be used to prepare for the Adobe Certified Associate exams.

Check out these useful links as well:

Adobe Forums: The website http://forums.adobe.com lets you tap into peer-to-
peer discussions, as well as questions and answers on Adobe products.

Adobe Premiere Elements 10 product home page: You can find even more infor-
mation at www.adobe.com/products/premiereel.

Free trial versions of Adobe Photoshop Elements 10 and Adobe Premiere 
Elements 10: The trial version of the software is fully functional and offers every 
feature of the product for you to test-drive (does not include Plus membership). 
To download your free trial version: http://www.adobe.com/cfusion/tdrc/index.
cfm?product=photoshop_elements&loc=en_us

www.adobe.com/support/premiereelements
http://tv.adobe.com
www.adobe.com/education
http://forums.adobe.com
www.adobe.com/products/premiereel
http://www.adobe.com/cfusion/tdrc/index.cfm?product=photoshop_elements&loc=en_us
http://www.adobe.com/cfusion/tdrc/index.cfm?product=photoshop_elements&loc=en_us
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4 Organizing YOur COntent

Lesson overview
Fast and efficient movie production is all about organization. In this 
lesson, you’ll learn how to do the following:

• Manually tag your clips in the Organizer

• Apply Smart Tagging in the Organizer

• Create an album for backing up your projects to Photoshop.com

• Create an InstantMovie using manual and Smart Tagging

• Drag clips to the My Project panel from the Project view

This lesson will take approximately two hours. 
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Tagging content in the Organizer.
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getting Started
Before you start working with the footage, let’s review a final version of the movie 
you’ll be creating.

1 Make sure that you have correctly copied the Lesson04 folder from the DVD in 
the back of this book onto your computer’s hard drive. For more information, 
see “Copying the Classroom in a Book Files” in the “Getting Started” chapter at 
the beginning of this book.

2 Launch Adobe Premiere Elements.

3 In the Welcome screen, click the Open Project button. If necessary, click Open 
in the pop-up menu. The Open Project dialog opens.

4 In the Open Project dialog, navigate to the Lesson04 folder you copied to 
your hard drive. Within that folder, select the file Lesson04_Start_Win.prel 
(Windows) or Lesson04_Start_Mac.prel (Mac OS), and then click Open 
(Windows) Choose (Mac OS). If a dialog appears asking for the location 
of rendered files, click the Skip Previews button.

Your project file opens with the Monitor, Tasks, and My Project panels open.

5 Choose Window > Restore Workspace to ensure that you start the lesson with 
the default window layout.

Viewing the Completed 
Movie Before You Start
To see what you’ll be creating in this lesson, you can take a look at the 
completed movie.

1 In the Project workspace in the Tasks panel, click the Media button ( ). In 
Media view, locate the file Lesson04_Movie.mov (which should be the only file 
available), and then double-click it to open the video into the Preview window.

2 In the Preview window, click the Play button ( ) to watch the video about 
a visit to the Georgia Aquarium, which you’ll build in this lesson.
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3 When you’re finished, close the Preview window.

Working in the Project Workspace
When you first open Premiere Elements, you see the Project workspace. I described 
the separate views and functions within this workspace in Lesson 1, but because 
you’re here now, let’s review. 

As you saw in the previous chapter, if you click Get Media ( ), you’ll enter 
Get Media view where you’ll capture or import video into your project. 

Media view ( ) should be open when you first run Premiere Elements. This is a 
customized view of the Organizer, which you can open by clicking the Organizer 
icon ( ) in the top toolbar. 

The InstantMovie icon ( ) starts a wizard that automatically and quickly 
steps you through the selection and editing portion of movie creation, allowing 
you to add theme-based effects, titles, transitions, and audio. You’ll produce an 
InstantMovie of the aquarium shoot later in this chapter. 

There’s some overlap between Media view and the Organizer application, so let’s 
look at their similarities and differences. The Organizer is a separate application 
that contains all audio, video, and still-image content that you’ve input into either 
Adobe Photoshop Elements or Premiere Elements since you first installed the pro-
grams. It’s a great place to start many projects and provides access to a wide range 
of organization and collection functions. 
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Media view works neatly within Premiere Elements’ Project workspace. It doesn’t 
offer the breadth of capabilities enabled by the full Organizer, but it’s convenient 
and provides a customized subset of functions that lets you efficiently find and 
deploy media within your movie projects. It also provides the ability to create cer-
tain types of media, such as titles, bars and tones, and color mattes, and the ability 
to organize your content into folders. 

As mentioned, Media view is the default view in the Tasks panel and should be 
open when you run Premiere Elements for the first time. If it’s not showing now, 
click Media in the Project workspace. 

When you first run Premiere Elements, if you load an existing project, Media view 
will display all content that you’ve imported into the project. For new projects, 
there will be no content in Media view. 

With this as background information, let’s take a deeper look at how you can find 
clips in Media view. 

Finding Clips in Media View
Let’s load some clips into the project so you can work with them in Media view.

1 In the Organize workspace, click the Get Media button ( ).

2 Click Files and Folders ( ). 

Premiere Elements opens the Add Media dialog. 

3 Navigate to the Lesson04 folder. Select the movie clips Clip01.mp4 through 
Clip13.mp4. Click Open (Windows)/Import (Mac OS).

Media view’s role is to help you find files using different search methods. Some 
basic search methods are available without any action on your part, and you can 
access advanced methods after you’ve rated the clips or have applied keyword or 
Smart Tags to your clips. I’ll discuss all of these options later in this lesson. In this 
short section, you’ll learn how to use the basic tools in Media view to find and 
organize your content. 

You can perform the following activities in Media view to view, create, and orga-
nize your files:

• Browse through the entire catalog by using the scroll bar at the right side 
of Media view.

• Change from List view to Icon view.

• Create folders and subfolders to organize your content and navigate the various 
levels of folders and subfolders.

• Sort by name or duration, either in ascending or descending order. 

 Note: Previous 
versions of Adobe 
Premiere Elements 
had a Media view and 
a Project view. Both 
functions have been 
consolidated starting in 
Premiere Elements 10.
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• Select which media type to show—or not to show—using icons on the right side 
of the Project view. 

A B C D E F G H I J

A. Switch to List view. B. Switch to Icon view. C. Go up one folder level.  
D. Create folder. E. Create new item. F. Clear. G. Sort by Name and Duration  
(ascending and descending). H. Show/Hide Video. I. Show/Hide Audio.  
J. Show/Hide Still Image.

1 Click the List icon ( ) to switch to List view (if necessary). Once in List view, 
you can sort your content by clicking the column head of any column. The 
arrow in the column you choose shows whether the data is sorted in ascending 
view or descending view. For example, click the Name column head to see how 
it sorts the content in the Media view. 

2 Click the Media view menu on the extreme upper right and choose Edit Columns 
to edit the columns presented and their order. Select the check box next to a 
column to include it in the Media view, and use the Move Up and Move Down 
buttons to change its order. Click OK to close the Edit Columns window. 
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3 Now you’ll create a folder to organize your videos. Click the Folder icon ( ) 
to create a folder. Premiere Elements creates a folder named Folder 01 with the 
text highlighted so it’s easy to change. Type in the word Videos, replacing the 
text “Folder 01.” 

4 Drag the source videos from the aquarium shoot into the new folder. Select all the 
source videos in the Media view (all files with a .mp4 extension), and then drag 
them into the new folder. Twirl the triangle next to the Videos folder to close it; 
your Media view should become a whole lot tidier. When you’re working with 
large projects with multiple video, still image, and audio files, creating folders is 
the best strategy for keeping your content organized and easy to find. 

5 To add a still image, video, or audio file to your project from Media view, 
drag the file from Media view into the Timeline or Sceneline in the My Project 
panel. Click No if Premiere Elements asks if you want to fix any quality issues in 
the clip or poses any other questions. 

 Note: Sometimes 
when you drop a clip 
into the My Project 
panel, you’ll see a 
message that says, “Clip 
being dropped contains 
solid background color. 
Do you want to apply 
Videomerge on this 
clip?” Click No if you see 
this message except as 
directed in Lesson 6.
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tagging in the Organizer
Media view is great for quickly finding clips, but the Organizer is Premiere 
Elements’ best tool for serious organization and search and retrieval work. You 
can open the Organizer by clicking the Organizer icon ( ) in the top 
toolbar. This exercise will detail how to perform manual and Smart Tagging in the 
Organizer, and then how to search for clips using those tags in the Organizer. 

Let’s start with a brief description of tagging, which you perform in one or more 
of three ways: assigning star ratings (1–5), applying keyword tags, and using Smart 
Tags. At a high level, all tags allow you to more easily find the clips to include in 
a particular movie. For example, if you review and rate all your clips on a scale of 
1–5, you can later search for only those clips that you rated 4 or higher—an easy 
way to find high-quality clips and eliminate poor-quality clips. 

Keyword tags allow you to tag a clip by person, location, event, or other designa-
tion with customizable categories. For example, in this exercise, you’ll apply several 
keyword tags to the clips from this project, and then search for clips containing 
these keyword tags. 

When you run the Auto Analyzer on a clip, Premiere Elements analyzes the video 
to detect scenes based on content; you can hunt for scenes with faces and iden-
tify scenes that are out of focus, shaky, underexposed, or overexposed. Using this 
qualitative data, Premiere Elements then categorizes all clips as high, medium, 
or low quality. This serves as a valuable triage function that you can later use to 
search for the best clips for your movie. This analysis is also used for features like 
Smart Trimming, which you’ll learn about in Chapter 5, and Automatic Quality 
Enhancement, which I’ll discuss in Chapter 6. 

For example, if you shot an hour of video on your last vacation, Smart Tagging 
allows you to identify medium-quality-and-higher clips containing faces (presum-
ably family members), and produce a movie containing only these clips. What 
would literally take you hours to accomplish manually, Smart Tagging can produce 
in a few moments. 

Using all these tags in any combination, you can hunt for clips to manually edit into 
a movie or create an InstantMovie, which is a professional-looking edited movie 
complete with titles, sound track, effects, and transitions that you’ll produce using 
a fast and simple step-by-step process. 
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tagging Clips in the Organizer
Let’s open and explore operations in the Organizer. To open the Organizer, click 
the Organizer icon ( ) in the top toolbar. To make your Organizer look 
like the one in the figure, click the View menu and make sure that Details, Show 
File Names, and Show People Recognition are all selected. 

1 Double-click the video Clip11.mp4 to open the file in the Organizer’s Preview view. 

A B C D E F G H I

A. Current position. B. Volume. C. Start. D. Record. E. Play (spacebar). F. Stop. G. End.  
H. Current time. I. Preview window.

 Note: Three 
keyboard shortcuts 
apply to all Premiere 
Elements’ preview and 
playback controls: Press 
the spacebar to start 
and stop clip playback, 
and use the arrow keys 
to navigate frame by 
frame forward (right 
arrow) and backward 
(left arrow).
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2 Click Play to play the video file, and use the playback controls to fast-forward, 
rewind, and otherwise experiment with these controls. 

3 Close the Preview window to return to the Organizer. 

Working with Star ratings
Follow the procedures described in this section to apply and delete star ratings, and 
to search for clips based on the star ratings. Ratings range from 1 to 5.

1 If you don’t see the star ratings, choose View > Details in the Organizer menu. 

2 Hover your pointer over the star ratings beneath any clip, and click the star that 
corresponds to the desired rating for that clip. Go ahead and rate a few clips so 
you can sort by rating in step 5.

3 To change a rating, use the same procedure and choose a different rating. 

4 To delete the star rating, click the last selected star on the right (the fourth star 
in a clip rated four stars). 

5 To find clips based on their assigned ratings in the Organizer (or in Media 
view), click the number of target stars and adjust the list box as desired. 
Premiere Elements displays only those files that meet the selected criteria.

B A

A. Target stars list box. B. Show All button.

6 Click the Show All button to view all clips in the Organizer (or in Media view). 

 Note: You can 
position the Organizer 
anywhere onscreen 
by grabbing the 
docking header and 
moving the panel to 
the new location. You 
can also resize the 
panel by grabbing and 
dragging any edge to 
the desired size.



66 Lesson 4 organizing Your Content

Working with Keyword tags
Premiere Elements includes general categories of keyword tags that you can apply 
as is or customize with your own categories or subcategories. In this lesson, you’ll 
create and apply two custom categories in the Organizer, and then search for clips 
based on those keywords in Media view.

1 Under Keyword Tags in the Organizer, click and select Events. Do not select the 
checkbox, just click the text as shown in the figure.

2 Under Keyword Tags, click the Create New button ( ) and choose New 
Sub-Category.

3 In the Create Sub-Category panel, type Georgia Aquarium Visit in the  
Sub-Category Name field. Then click OK. 

Premiere Elements creates the new subcategory. 

4 Repeat steps 2–3 to create three subcategories beneath Georgia Aquarium Visit 
called Fun Fish, Man Eaters, and Petting Tank. 
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5 In the Browser panel, click Clip02.mp4. Then press and hold the Ctrl key 
(Windows)/Command key (Mac OS), and click Clip04.mp4.

6 Drag the Fun Fish keyword tag to either of the selected clips. When you release 
the pointer, Premiere Elements applies the keyword tag to all selected clips. 

7 Use the same procedure to apply the Man Eaters tag to Clip05.mp4, Clip06.
mp4, Clip08.mp4, and Clip09.mp4; the Petting Tank tag to Clip10.mp4, Clip11.
mp4, and Clip12.mp4; and the Georgia Aquarium Visit tag to Clip01.mp4, 
Clip03.mp4, Clip07.mp4, and Clip13.mp4 (because they don’t fall into any of the 
three more specific categories). 

8 Click the box to the left of the Man Eaters subcategory, and a pair of binoculars 
will appear in the box. This tells the Organizer to display only those clips tagged 
with that keyword tag.

about the auto analyzer
As mentioned earlier, the Auto Analyzer analyzes your video clips for content and 
quality, and is integral to a number of functions, including Smart Tagging, Smart 
Trimming, and creating InstantMovies, which you’ll learn to do later in this chap-
ter. You can run the Auto Analyzer manually, as you’ll learn in the next section, or 
run it as a background process. In fact, by default, the Auto Analyzer will run on 
clips that you’ve imported anytime your system is running and idle. 

To access this preference option, in the Organizer, choose Edit > Preferences > 
Media-Analysis (Windows) Adobe Elements 10 Organizer > Preferences > 

 Note: If your 
Organizer shows 
multiple copies of any 
of the mentioned files, 
just choose any copy of 
that file. 
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Media-Analysis (Mac OS). In the default setting, Premiere Elements will work in 
the background with imported media, so when you’re ready to edit, you won’t have 
to wait for the Auto Analyzer to run. 

In most instances on most computers, background operation should work just fine. 
On older, less powerful computers and those configured with the minimum RAM, 
background operation may cause a noticeable drag on foreground operations, par-
ticularly when working with H.264-based, high-definition formats such as AVCHD 
and video shot by DSLRs. If you notice any sluggishness in your foreground opera-
tions after importing footage or experience any system instability, try disabling the 
Auto Analyzer as a background operation by deselecting the Analyze Media for 
Smart Tags Automatically check box. 

running the auto analyzer Manually
To manually run the Auto Analyzer and apply Smart Tags to the project clips,  
follow these steps. 

1 If the Organizer isn’t open, click the Organizer icon ( ) in the Project 
workspace to open the Organizer. Otherwise, press Alt+Tab (Windows) or 
Command+Tab (MacOS) to switch to Organizer view.

2 Click to select all clips, and then right-click and choose Run Auto-Analyzer. 
This can take a while, so you might want to try one or two clips first.
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E Tip: As with keyword tagging, you can use the tags created via Smart Tagging by themselves or 
in conjunction with keyword tags or even star ratings. For example, in the Organizer, click three stars 
“and higher” in the top toolbar, click the Petting Tank tag in the Keyword Tags, and click In Focus in 
Smart Tags. Premiere Elements will display only those clips that meet these criteria.

3 Premiere Elements starts analyzing the clips and reports its progress in the 
Elements Organizer. The duration of the process will vary by clip length, clip 
format, and the speed of your computer. After completion, Premiere Elements 
will open the Elements Organizer window to let you know the process has 
completed; click OK to close that window.
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4 In the Organizer, if necessary, press Ctrl+D (Windows)/Command+D (MacOS) 
to ensure that Details are showing. A purple tag ( ) beneath the clip’s thumbnail 
indicates that Smart Tagging has been applied. Tags of different colors ( )  
indicate that keyword tags have been applied, whereas the Album tag ( ) in the 
Organizer indicates only that the clip is in an album. To view which tags have 
been applied or which album(s) the clip was included in, hover your cursor over 
the respective tag in either the Organizer or Media view. Tagging details will 
appear beneath the Preview window. 

5 To remove a tag, right-click the tag in the Organizer and delete the tag, or right-
click the thumbnail in Media view and choose the tag to remove.

Working with Clips after Smart tagging
Let’s take a moment to understand what happens to clips after Smart Tagging. 
To review, during Smart Tagging, Premiere Elements breaks the clip into different 
scenes based on content changes (as opposed to timecode, like DV files); finds dif-
ferent types of content like faces; and rates the quality of each clip based on factors 
such as exposure, focus, and stability. 

In the Organizer, you’ll know that the clip has been split into multiple scenes 
if there is a Step Forward icon ( ) on the right of the clip. Click that icon, and 
Premiere Elements displays all scenes separately in the Organizer surrounded by a 
border that’s a lighter gray than the rest of the Organizer. This lets you know that 
all the scenes are part of a single clip. 
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In the Organizer, you can treat each scene as a separate clip, for example, dragging 
it to the My Project panel to include it in a project or double-clicking it to play it 
in the Preview window. You can consolidate all scenes back into a single frame by 
clicking the Step Backward icon to the right of the final scene ( ). Note that you 
can expand and contract a clip into its separate scenes in Project view using these 
same controls. 

Creating an instantMovie
In this exercise, you’ll create an InstantMovie from the aquarium clips that you 
tagged in a previous exercise. Again, an InstantMovie is a professional-looking 
edited movie, complete with titles, sound track, effects, and transitions that you’ll 
create by following a simple wizard. 

1 If necessary, switch to Media view. Then double-click the Videos folder to open 
it. Note how the Up One Folder icon becomes active once you’re in this folder. 
After you create the InstantMovie, you can click this icon to navigate back to 
the root folder in Media view. 

2 Press Ctrl+A (Windows)/Command+A (MacOS) to select all clips in the Media 
view, and then click the InstantMovie ( ) button. Premiere Elements 
opens the InstantMovie Wizard. You can preview any Style by clicking it, and 
stop the preview by clicking it again. 

3 Choose Fun Style and click Next. If this theme is not available, choose another.

 Note: The Apply to: 
radio buttons become 
active only when you 
apply a Theme to clips 
already inserted into 
the My Project panel, 
not when you create an 
InstantMovie from the 
Organizer.
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4 Customize the Theme as desired. Accept the options as is, or do any or all of 
the following: 

• Customize the Opening and Closing Titles.

• Select the Auto Edit check box to have Premiere Elements analyze your clips 
and edit them to fit the selected theme, which is recommended. If you don’t 
select Auto Edit, Premiere Elements uses the clips as is and doesn’t edit 
them. Also choose whether or not to apply the Auto Analyzer to clips that 
you haven’t previously analyzed. 

• In the Music box, choose the Theme Music radio button to use the 
background music from the selected Theme, or choose the No Music radio 
button. To use your own background music, click the My Music radio 
button, and then click the Browse button to choose the song you want. Then 
drag the Music/Sound FX slider to the desired setting, dragging to the right 
to prioritize audio captured with the video clips and to the left to prioritize 
the selected background music. If you have dialogue in your project (which 
these clips don’t), select the SmartMix check box and Premiere Elements will 
reduce the volume of the music track when it detects dialogue. 

• In the Speed and Intensity box, adjust the Effects and Cuts sliders as desired. 

• In the Duration box, choose the desired option. Match Music produces a 
movie that matches the duration of the selected music and is recommended. 
Or, you can specify a duration or choose Use All Clips, which uses all clips at 
their original duration with no background music. 

• In the Sequence box, choose Theme Order (recommended), which allows 
Premiere Elements to use clips as they best match the theme, or choose 
Time/Date, which uses the clips in the order that they were shot. 

• In the Theme Content box, choose the content to incorporate into 
the InstantMovie and whether to replace any existing content with 
theme-based content. 

• In the Render Preview box, choose Yes to render a preview of the 
InstantMovie after completion or No to preview in real time from the 
My Project panel (recommended). 
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5 After selecting your options, click Apply to create the InstantMovie. Click 
No when the InstantMovie dialog opens and asks if you want to select more 
clips. Click No when Premiere Elements asks if you want to render the 
movie. Premiere Elements creates the InstantMovie and inserts it into the 
My Project panel. 

6 Premiere Elements adds the InstantMovie to the My Project panel (either 
Timeline or Sceneline, whichever was selected) in consolidated form. To 
separate the InstantMovie into its components to edit them, click to select 
the new InstantMovie, right-click, and choose Break apart InstantMovie. 
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7 Use the playback controls in the Monitor panel to preview the InstantMovie. 

A

D E F G H I J K L M N O P Q R

B C

A. Docking header. B. Preview area. C. Monitor menu. D. In Point handle. E. Current position.  
F. Current time in movie. G. Go to previous edit point (page up). H. Rewind. I. Step back (left).  
J. Play/Pause toggle (spacebar). K. Step forward (right). L. Fast-forward. M. Go to next edit point 
(page down). N. Out Point handle. O. Shuttle. P. Split clip. Q. Add default text. R. Freeze frame.

uploading Files to Photoshop.com
Depending on your membership level in Photoshop.com, you can back up at least 
2 GB of video, audio, and still-image files to the site. To upload files, you must first 
create an album, and then add the video file to that album. 

Follow this procedure to back up video files to Photoshop.com. 

1 If necessary, click the Organizer icon ( ) in the Project workspace to 
open the Organizer. 

2 Under Albums in the Project workspace, click the Create New Album or Album 
Group button and choose New Album. Premiere Elements opens the Create 
Album panel. 

 Note: Photoshop.com 
services are currently 
available for Premiere 
Elements users only in 
the United States.
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3 In the Album Name field, type Georgia Aquarium, and make sure that the 
Backup/Sync check box is selected. Then click Done to close the panel. 

4 Because you also used Georgia Aquarium as the name of a subcategory in 
Events, Premiere Elements will open a dialog asking if you want to create an 
album with that name. Click OK to close that dialog. If you’re not signed in, a 
dialog will appear asking you to enter your account information or to register.

5 In the Keyword Tags box, select the check box next to the Georgia Aquarium 
tag. The Organizer will display only those clips previously tagged with the 
Georgia Aquarium tag or a tag from any of the three subcategories.



76 Lesson 4 organizing Your Content

6 Press Ctrl+A (Windows)/Command+A (MacOS) to select all clips. 

7 Drag the Georgia Aquarium album tag to any of the selected clips. When you 
release the pointer, the album tag is applied to all selected clips. 

8 In the Organizer menu, choose Edit > Preferences > Backup/Synchronization 
(Windows) Adobe Elements 10 Organizer > Preferences > Backup/
Synchronization (Mac OS). In this panel, if not already selected, do the following:

• Select the Backup/Sync is On check box.

• Click the Advanced Backup/Sync Options disclosure triangle to reveal the 
advanced options. Here’s where you can set options, such as which file types 
to archive and how to resolve conflicts between your online and desktop 
albums. Adjust these options as desired. 

• Select the Sync check box for Georgia Aquarium.

 Note: Once you 
create the album, you 
may be prompted 
to log into www.
Photoshop.com. If you 
haven’t created an 
account, you can do so 
by clicking Join Now on 
the www.Photoshop.
com Home page. If you 
don’t have an account 
or aren’t currently 
logged in, you’ll get an 
error message in your 
Preferences panel. 

www.Photoshop.com
www.Photoshop.com
www.Photoshop.com
www.Photoshop.com
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9 Click OK to close the Preferences panel. 

10 Unless you have a burning desire to store random videos from the Georgia 
Aquarium on your Photoshop.com site, under Albums in the Project workspace, 
click the Georgia Aquarium album, and then click the Delete Album button ( ).  
Premiere Elements will delete the album and remove any files from that album 
previously uploaded to Photoshop.com. 

 Note: You must  
be logged into 
Photoshop.com to  
view the Advanced 
Backup/Sync Options 
screen.

 Note: Synchronizing 
video files seems 
like a great idea, but 
remember that only ten 
minutes of DV or HDV 
video will consume the 
entire 2 GB of starter 
storage space on 
Photoshop.com. Keep 
that in mind when you 
select the file types to 
synchronize.



78 Lesson 4 organizing Your Content

Working with Smart albums
You know the drill. It’s holiday time or perhaps birthday time, and you’re thinking, man, I’ve gotta 
create a year-in-review video or perhaps a new photo collection. If you’ve been applying tags to your 
video all year long, you should be able to quickly search for what you want via some combination of 
tags, Smart Tags, star ratings, and date selection. 

Alternatively, using a Smart Album in Premiere Elements, you 
can see all the relevant content with the click of a button. Simply 
stated, a Smart Album contains information based on search 
criteria that you insert when you create the Smart Album.

To create a Smart Album, click the Create New Album or Album 
Group button and choose New Smart Album. Premiere Elements 
opens the New Smart Album panel.

In the New Smart Album panel, you can add any number of 
search criteria, including keyword tags, date tags, and Smart Tags. In this example, the New Smart 
Album will identify all content tagged for any of my four daughters (Rose, Whatley, Franzi, and Vici) 
that was shot during 2011 and is judged High Quality and In Focus by Premiere Elements. When I’m 
ready to produce that year-end video, all I have to do is click the Kids—2011 Smart Album, and the 
content will be there waiting for me. 
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review Questions
1 What’s the difference between the Organizer that ships with Premiere Elements and 

the Organizer that ships with Photoshop Elements?

2 What is Smart Tagging? Are there any situations in which you wouldn’t want to apply 
Smart Tagging? 

3 After creating an InstantMovie, how do you break up the movie to edit it further? 

4 How do you upload your clips to Photoshop.com?

review answers
1 This is a trick question—there is no difference. If you have Premiere Elements and 

Photoshop Elements installed, both programs can insert content into the same shared 
database and sort through and retrieve data from that database.

2 When you apply Smart Tagging to a clip, Premiere Elements analyzes the clip to detect 
scenes based on content, hunts for certain content types such as faces, and ranks 
the quality of your clips. Other than processing time, there’s very little downside to 
applying Smart Tagging. Your video clips will be divided into useful scenes, and you 
can find high-quality clips much faster than you could manually. 

3 Click the clip with your pointer to select it, and then right-click and choose Break 
apart InstantMovie. 

4 To upload clips to Photoshop.com, create an album in the Organizer and drag the new 
album tag onto the target clips. Then access the Organizer Preferences panel and make 
sure that that album is synced with Photoshop.com.
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A

action-safe guides, 289
action-safe margins, 176
Add Object/Track Object procedure, 147
Adobe Community Help, 4
Adobe Forums, 5
Adobe Systems website, 298
Adobe TV, 5
albums

applying keyword tags to, 75–76
creating, 74–76, 78, 283–284
deleting, 77
naming, 75, 284
Smart Albums, 78
synchronizing, 76–77

alignment
objects, 182
text, 182, 291
transitions, 159, 162

analog camcorders, 10, 38
analog video, 38, 52
animating

buttons, 250–253
effects with keyframes, 136–140
still titles, 185

Anti-aliasing Quality control, 163
artistic effects, 112
aspect ratio, 27–31, 273
audio, 196–216

adding to menus, 247, 249–250
background noise, 207, 209, 215
beat detection, 214–215
capturing without video, 43
clipping, 209
dialogue, 223
exporting audio only, 278
gain controls, 206–209
inserting in menu background, 249–250
linking/unlinking with video, 214
music. See music
narrating movies, 201–209, 212
normalization, 209
SmartMix feature, 72, 204–206
trimming linked video and, 214
using Audio Mixer, 212–214

volume adjustments, 204–212, 215
waveforms, 207, 208–209

audio effects. See also effects
deleting, 115, 126
using, 110–111
viewing, 16
working with, 215–216

audio files
adding to projects, 62
compression, 258
importing, 38
inserting as menu background, 250
keyframes in, 205
links in, 214

Audio format, 275
Audio Mixer, 212–214
audio tracks. See also tracks

customizing view, 96
displaying, 94, 204, 205
SmartSound Quicktracks, 199–201
volume control, 204–216
working with, 94–96

audio transitions, 16, 153
Audio Transitions folder, 153
Auto Analyzer

capturing video, 47
considerations, 63
overview, 67–68
preferences, 67–68
running in background, 67–68
running manually, 68–70
Smart Trim and, 103
SmartFix and, 114–115

Auto Save feature, 32, 33
Auto Tone & Vibrance effect, 116–118, 123
Auto Tone effect, 117
Auto-Play button, 233
auto-play discs, 233–234
AV DV converters, 52
AVCHD camcorders, 16, 30, 47–52, 266
AVCHD discs

burning, 229–230, 258–260
overview, 229–230
quality settings, 260

AVCHD files, 275
AVCHD format, 229, 258, 275
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B

background color, 62, 142, 143
background music, 199–201, 223, 245
background noise, 207, 209, 215
background rendering, 86
backlighting, 126–128
backups, 21, 74–77
Balance effect, 112
beat detection, 214–215
bevels, 292
black balance, 122
black video clips, 173–174
Blu-ray Discs. See also DVDs

adding scene markers, 231–232
auto-play, 233–234
burning, 229–230, 258–260
overview, 229–231
quality settings, 260

Blu-ray format, 229–231, 275
BMP files, 278
bonus clips, 242–244, 245
bounding box, 246, 247, 290
Browser pane, 10
burning DVDs, 229–230, 258–260
buttons

animating, 250–253
changing text properties for, 253–255
customizing, 251–253
modifying scene markers, 239–242
navigation, 239, 242, 253
overlapping, 251
playback, 233, 253
text, 251–255
thumbnail scene, 250–255

C

camcorders. See also video devices
AVCHD, 16, 30, 47–52, 266
capturing video from, 37, 38–47
capturing video without device control, 45
connecting to computer, 40–42
device control for, 44–45
DSLR, 30, 260
DV, 10, 16, 48–49, 83
HDV, 10, 16, 26, 48–49. See also camcorders
importing video from AVCHD, 16, 30, 47–52
inputting video footage from, 10
previewing video on TV monitor, 83
tape-based, 10
troubleshooting problems, 47, 48–49
types of, 10, 16

cameras, digital, 10, 16, 38, 52
Capture panel, 39, 40–47

capturing video, 38–47
Auto Analyzer and, 47
from camcorders, 37, 38–47
capture interfaces, 39–40
Capture to Timeline option, 43
capturing without audio, 43
capturing without device control, 45
capturing/splitting into scenes, 43–44
device control, 44–45, 52
options for, 43–44
overview, 38
saving imported files, 50–51
Scene Detect and, 43–44
stop-motion video, 51
stopping capture, 46, 47
from tape-based devices, 10, 40–47
time-lapse video, 51
troubleshooting problems, 47, 48–49
from webcams, 16, 40, 42, 44, 45

Cartoonr Plus effect, 112, 147–148
cell phones. See mobile phones
clipping, 209
clips. See also content; video footage

adding in Sceneline, 86–89
adding to menus, 247–249
black, 173–174
bonus, 242–244, 245
compositing with Videomerge, 142–144
correcting shakiness of, 130–131
deleting, 90
editing. See editing
effects. See effects
enhancing, 115–123
finding in Media view, 60–62
importing. See importing
keywords. See keyword tags
layering, 93, 95
moving, 89
playing. See playback
previewing, 58–59
reframing, 128–130
rendering, 118–120
reversing, 112
running Auto Analyzer on, 63, 67–70
sharpening, 130
SmartFix adjustments, 114–115
speed of, 112, 131, 144–145
splitting, 92–93, 99–103
superimposed, 141–142
superimposing titles over video, 185, 186–189
synchronizing, 76–77
tagging, 63–78
transitions in. See transitions
trimming. See trimming clips
working with multiple, 127
zoom controls. See zoom controls
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color
background, 62, 142, 143
saturation, 117
text, 180–181, 187–188, 255
titles, 180–181, 187–188

color correction, 120–123
Community Help, 4
compression, 258
computers

connecting video devices to, 40–42
sharing movies from, 271–274
system requirements, 2

content. See also clips; video footage
adding to projects, 62
importing from hard drive, 16, 53
in Media view, 60–62
navigating in, 83–85
organizing. See organizing content
sorting, 61
synchronizing, 76–77
tagging. See tagging
uploading to Photoshop.com, 74–77

content-based scene detection, 43, 44
Create panel, 11
credits, 189–191
curative effects, 111
current-time indicators, 83, 131, 138, 154

d

data transfer rate, 41
decibels, 207
DeNoiser filter, 209
Detect Beats option, 214–215
device control

AV DV converters and, 52
capturing clips with, 44–45
problems with, 47, 48–49

devices
available, 50
camcorders. See camcorders
cameras, 10, 16, 38, 52
connecting to computers, 40–42
mobile, 49, 276–277
supported, 40
tape-based, 10, 40–47, 51
video, 16, 45–46

dialogue, 72, 223
digital cameras, 10, 16, 38, 52
disc formats, 229–231
disc menu templates, 236–239, 245
Disc Menus workspace, 17–18
docking/undocking panels, 33, 34
drop shadows, 292
drop zones, 247, 248, 249
DSLR camcorders, 30, 260

DSLR cameras, 38, 266
DV AVI format, 275
DV camcorders, 10, 16, 48–49, 83. See also camcorders
DVD formats, 229–231
DVD players, 229
DVD-based camcorders, 16, 47–52
DVD-Recordable media, 229
DVDs. See also Blu-ray Discs

adding scene markers, 231–232
auto-play, 233–234
burning, 229–230, 258–260
copying lesson files from, 3–4
menus for. See menus
overview, 229–231
Web DVDs, 256–258, 260, 269

DVD-Video format, 229, 258

e

Edit in Photoshop Elements command, 296–297
edit points, 84, 85, 92, 99
Edit workspace, 16–17
editing, 80–106

color correction, 120–123
images in Photoshop Elements, 285–287
InstantMovies, 72, 74
Photoshop images in Premiere Elements, 296–297
SmartFix adjustments, 114–115
split edits, 214
in Timeline, 96–99
trimming. See trimming clips
working with keyframes, 136–140

effects, 108–148
animating with keyframes, 136–140
applying, 116–118, 127
artistic, 112
audio, 16, 110–111, 215–216
Auto Tone & Vibrance, 116–118, 123
Cartoonr Plus, 112, 147–148
choosing, 116
compositing clips, 142–144
copying to/from clips, 123–131
curative, 111
deleting, 115, 126, 127
disabling, 115
displaying all, 112
effect masking, 147–148
exploring, 148
fades. See fading in/out
fixed, 111, 112, 126
gallery of, 110
glow, 292
GPU, 165
image control, 112, 116–123
location of, 110
metallic, 136–138
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motion controls, 112, 128–130, 145–147
opacity, 112
overlay, 112
pan and zoom, 112, 132–135
Picture-in-Picture overlay, 141–142
playback speed, 112, 131, 144–145
presets, 16
previewing, 118–119
rendering, 86, 118–120
Shadow/Highlight, 114, 115, 126–128
sharpening, 130
sound, 215–216
standard, 110, 126
Three-Way Color Corrector, 120–123
for titles, 185
toggling on/off, 115, 117
types of, 111–113
undoing, 118
using, 110–113
video, 16, 110–111, 148
Videomerge, 142–144
Vintage Photo, 291
Volume, 112
warped text, 293–294
zoom, 112, 132–135

Effects Properties view, 113, 114, 124
Effects view, 16
End key, 86
exporting. See also uploading movies/files

audio only, 278
frames as still images, 277–278
movies to Facebook, 269–271
movies to mobile phones/players, 276–277
movies to websites, 268–269, 271
snapshot export function, 278

eye icon, 115, 117, 127, 131

F

Facebook, 269–271
fading in/out

single-sided transitions for, 163–164
title clips, 183–184
using keyframes, 138–140
volume, 210–211

files. See also projects
audio. See audio files
AVCHD, 275
backing up to Photoshop.com, 74–77, 263, 268–269
BMP, 278
compatible movie formats, 275
finding, 60–62
lessons, 3–4
opening, 58, 64–65
optimizing for video, 288–289
organizing, 60–62

synchronizing, 76–77
uploading. See uploading movies/files
video. See video files
Windows Media, 275

finding items
files, 60–62
in Smart Albums, 78

Fix panel, 11–13
fixed effects, 111, 112, 126
Flash Video (FLV) format, 266, 275
folders

considerations, 2
creating, 62
finding clips, 60, 62
importing content, 53
organizing content in, 60, 62
ScratchDisks, 32
for storing audio/video, 32
for storing transitions, 153

fonts, 177–179, 238, 254, 291. See also text
footage. See video footage
forums, 5
fps (frames per second), 31
frames. See also keyframes

advancing, 85
exporting as still images, 277–278
locating, 83, 85
moving to specific, 84
navigating between, 64, 84, 85
sharing single movie, 277–278
showing head/tail, 96
timecode and, 83
trimming. See trimming clips

frames per second (fps), 31
Freeze Frame dialog, 277–278

G

gain controls, 206–209
Get Media view, 16, 38, 45, 49
glow effects, 292
GPU (Graphics Processing Unit) effects, 165

H

hard disk
importing video content from, 16, 53
space required for DV editing, 41

HDV (High Definition Video), 26, 130, 256, 266
HDV camcorders, 10, 16, 26, 48–49
HDV presets, 30–31
help features, 4, 5, 298
High Definition Video. See HDV
History panel, 20
Home key, 86
Horizontal Type tool, 174, 180, 291



304 Index

I

IEEE 1394 connectors/ports, 40–42, 45, 48, 230
Image Control effects, 112, 116–123
Image format, 275
images

adding to menus, 247–249
adding to titles, 182–183
changing menu thumbnail, 239–242
combining with video, 101–103
copying/pasting, 189, 289–290
editing. See editing
importing. See importing
menu thumbnails, 239–242
sending to Premiere Elements, 285–287
still, 31, 62, 112, 247–249

importing
audio/video clips, 39–40
content from hard disk, 16, 53
Photoshop images, 285–290, 294–295
video with Video Importer, 39–40, 47–52

Info panel, 19
In/Out points, 90–91, 97, 248, 250
InstantMovie view, 16
InstantMovies, 220–224. See also movies

breaking apart, 73, 224
considerations, 223
creating, 71–74, 223
described, 71
editing, 72, 74
playback controls, 74, 224
previewing, 72, 74, 224
selecting music for, 72
tags and, 63
themes, 71–72, 220–221

Interest Level threshold, 105–106
interlaced video, 31
iPod/iPhone movies, 16, 49, 276–277

J

J-cuts, 214

K

kerning text, 177–178
keyboard shortcuts

playback controls, 64
preview controls, 64
zoom controls, 94, 296

keyframes. See also frames
animating effects with, 136–140
audio adjustments with, 210–211
in audio files, 205
creating, 210
creating fade-outs with, 138–140

creating image pan with, 132–135
deleting, 140, 210
described, 135
modifying, 140
opacity, 138–140
showing, 140
working with, 135–140

keyword tags. See also tagging
applying to albums, 75–76
applying to clips, 67
categories/subcategories, 66
described, 63
working with, 66–67

L

layer styles, 296
layering, 93, 95
L-cuts, 214
lesson files, 3–4
letterboxes, 27–29
List view, 61

M

markers
menu. See menu markers
scene. See scene markers
stop, 242, 243–244, 245

masking, 147–148
Media view

adding content to projects, 62
content displayed in, 60
described, 16, 60
finding clips in, 60–62
organizing files in, 60–62
vs. Organizer, 59–60, 63
vs. project view, 56

menu markers. See also markers
main menu markers, 244, 245
setting, 242–244
stop markers, 242, 243–244, 245

menus, 226–261
adding audio to, 247, 249–250
adding images to, 247–249
adding video to, 247–250
buttons on. See buttons
creating DVDs with, 236–239
customizing, 245–250
image thumbnails, 239–242
previewing, 228–229, 238, 242
submenus, 242–245

metallic effect, 136–138
midtones, 122
Mixer Options dialog, 204–206
mobile devices, 49, 276–277
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mobile phone movies, 16, 49, 276–277
mobile phones, 16, 49, 276–277
Monitor panel

customizing, 33–34
overview, 14
playing movies in, 83–85
vs. Sceneline, 83
vs. Timeline, 83
working with, 83–86
zoom controls in, 85–86

motion controls, 112, 128–130, 145–147
Motion Tracking effect, 145–147
Move tool, 292, 296
movies. See also projects; video

adding clips to, 87–89
combining video/still images, 101–103
exporting. See exporting
Flash, 266, 275
importing. See importing
InstantMovies. See InstantMovies
iPod/iPhone, 16, 49, 276–277
mobile phone, 16, 49, 276–277
moving to beginning/end of, 86
narrating, 201–209, 212
navigating in, 83–85
playing. See playback
previewing. See previewing
QuickTime, 271, 275, 282
safe zones for TV, 176
scrubbing through, 84
sharing. See sharing movies
themes, 71–72, 218–225
transitions in. See transitions
uploading. See uploading movies/files
viewing, 58–59
YouTube, 266–268
zoom controls. See zoom controls

MPEG format, 275
music

background, 199–201, 223, 245
detecting beat of, 214–215
fading in/out, 210–211
playback, 200, 202
selecting for InstantMovie, 72
theme, 72, 223

My Project panel
customizing, 33–34
overview, 14–15
Sceneline view and, 86–92
switching between views, 86
Timeline view and, 93–96
Zoom controls in, 94

n

narration, 201–209, 212
navigation

DVD menus, 236
frames, 64, 84, 85
hard drives, 53
in movies, 83–85
root folder, 71
scenes, 47, 241
shuttling through movie, 45, 74, 84

navigation buttons, 239, 242, 253
New Project panel, 12
noise, background, 207, 209, 215
normalization, 209
NTSC settings, 44, 272

O

objects
adding, 147
aligning, 182
animating, 51
deleting from scenes, 90
menu buttons, 253
tracking, 145, 147

opacity, 112, 138–140, 183–184
Opacity effect, 112
opacity keyframes, 138–140
Organize panel, 11, 222
Organize workspace, 60
Organizer, 56–79

described, 59
moving/resizing, 65
opening, 63, 64
opening files in, 60
tagging in, 63–78
using, 8–20, 282–284
vs. Media View, 59–60, 63
work area, 10, 86, 120
working in, 10–20

organizing content, 56–79
Auto Analyzer, 67–70
in folders, 62
keywords. See keyword tags
in Media view, 60–62
overview, 58
on Photoshop.com, 74–77
in Project workspace, 59–60
Smart Albums, 78
sorting data, 61
star ratings, 63, 65
tagging. See tagging
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Out/In points, 90–91, 97, 248, 250
output resolution, 274
overlay effects, 112
overlays, 90
overscan, 176

P

PAL settings, 44, 271
Pan and Zoom tool, 112, 132–135
panning images, 112, 132–135
phones. See mobile phones
Photoshop Elements, 280–299. See also Premiere Elements

creating files optimized for video, 288–289
creating Premiere Elements projects in, 285–287
customizing titles in, 289–295
editing images in Premiere Elements, 296–297
launching/getting started in, 282–284
sending images to Premiere Elements, 285–287
using with Premiere Elements, 280–299

Photoshop.com
account creation, 75
availability of, 74
backups to, 21, 74–77
logging in to, 268
sharing movies via, 263, 268–269
synchronizing video on, 21, 76–77
uploading files/movies to, 74–77, 263, 268–269
uploading Web DVDs to, 256–257, 269
working with, 8, 20–22

Picture-in-Picture overlay, 141–142
pixel aspect ratio, 28, 30–31
Play buttons, 233, 253
playback

with Auto-Play button, 233
auto-play discs, 233–234
InstantMovie, 74
in Monitor panel, 83–85
music, 200, 202
pausing, 80–106
Play buttons, 253
with Play/Pause toggle, 45, 64, 74, 83
quality, 119
reversing playback, 112, 131
shortcuts, 64
with spacebar, 45, 64, 74, 83
speed, 112, 131, 144–145
starting/stopping, 64, 83

player movies, 276–277
Play/Pause toggle (spacebar), 45, 64, 74, 83
preferences

Auto Analyzer, 67–68
Auto Save, 32
Backup/Synchronization, 21, 76
Device Control, 48

General, 31–32
Premiere Elements, 31–33
projects, 31–33
Scratch Disk, 32
Transitions, 155, 165, 287

Premiere Elements. See also Photoshop Elements
editing Photoshop images in, 296–297
help features, 4, 5
importing Photoshop images, 285–290, 294–295
installing, 3
preferences. See preferences
presets. See presets
project settings for, 26–31
resources, 4–5, 298
system requirements, 2
using with Photoshop Elements, 280–299
workflow in, 8, 288
workspace for, 8–10

presets
AVCHD camcorders, 266
choosing, 30–31
DSLR cameras, 266
effects, 16
for exporting to mobile devices, 276
information about, 26
resolution, 274
saving, 125
for sharing on personal computer, 271–274
for sharing on Photoshop.com, 268
for sharing on YouTube, 266
standard definition (SD), 274
using, 26, 27
viewing, 125

Preview Disc window
creating auto-play discs, 233–234
modifying scene marker buttons, 241–242
working with, 228–229

Preview view, 64–65
Preview window, 58–59, 71
previewing

animations, 185
clips, 58–59
effects, 118–119
InstantMovies, 72, 74, 224
keyboard shortcuts, 64
menus, 228–229, 238, 242
movies, 58–59, 71
in Premiere Elements, 86
quality of, 119
rendering, 72, 73
shortcuts, 64
skipping, 58
transitions, 155, 158, 163, 164, 166
video on TV, 83, 176, 233, 239

progressive video, 31
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Project view, 56, 60
Project workspace

overview, 15–16
working in, 59–60

projects. See also files; movies; video
adding content to, 62
creating in Photoshop Elements, 285–287
designating chapters in, 231–232
exporting. See exporting
opening, 33, 58, 64–65, 236
playing. See playback
preferences, 31–33
previewing. See previewing
recent, 33, 236
rendering, 86, 119, 256, 257, 274
saving, 32, 33
settings, 26–31

Properties view, 19
Push transition, 155–156

Q

quality issues
analyzing. See Auto Analyzer
anti-aliasing and, 163
considerations, 63
disc capacity and, 260
fixing with SmartFix, 13
identifying suboptimal clips, 105–106
output format, 275
playback, 119
previews, 119
rating quality, 70
tagging poor-quality clips, 63

Quality Level threshold, 105–106
QuickTime, 271, 275, 282

R

recordable discs, 230
rendering

background, 86
effects, 86, 118–120
previews, 72, 73
projects, 86, 119, 256, 257, 274
transitions, 165
work area, 86, 120

resolution
Blu-ray/AVCHD discs, 260
considerations, 30–31
output, 274
presets, 274
video, 30–31, 266
YouTube, 266

resources, 4–5, 298
rewritable discs, 230
ripple deletion, 90
rolling credits, 189–191

S

saving
Auto Save feature, 32, 33
imported files, 50–51
presets, 125
projects, 32, 33

Scene Detect feature, 43–44
Scene Marker buttons, 239–242
scene markers. See also markers

adding, 231–232
automatically generating, 234–236
button labels/image thumbnails, 239–242
described, 245

Sceneline view. See also Timeline view
adding clips, 86–89
deleting clips, 90
described, 14
moving clips, 89
slide shows, 101–103
Split Clip tool, 92–93
switching between views, 86
trimming clips, 90–92, 93
vs. Monitor panel, 83
working in, 81
working with My Project panel, 86–92

scenes
deleting objects from, 90
navigation, 47, 241
restoring, 90
splitting video into, 43–44

Scratch Disk preferences, 32
scrubbing through video, 84
SD cards, 38, 49
SD presets, 274
SD (standard definition) video, 26, 114, 130, 163, 256
searches

for files, 60–62
Smart Albums, 78

settings-related issues, 27–31
Shadow Amount slider, 127
Shadow/Highlight effect, 114, 115, 126–128
shadows, drop, 292
Share panel, 11
Share workspace

burning discs, 259
overview, 18
sharing/exporting video, 264, 268, 274
Web DVD creation, 256
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sharing movies, 262–279
from computer, 271–274
considerations, 264
presets for. See presets
sharing single frames, 277–278
via Facebook, 269–271
via mobile phones/players, 276–277
via Photoshop.com, 263, 268–269
via YouTube, 266–268

sharpening clips, 130
Shuttle control, 45, 74, 84
Skip Previews button, 58
slide shows

creating, 101–103
length of, 287
using Photoshop images, 285–287

Smart Albums, 78
Smart Tags, 11, 68–70, 78, 220
Smart Trim mode, 103–106
SmartFix feature, 114–115
SmartMix feature, 72, 201–203
SmartSound Quicktracks, 199–201
snapshot export function, 278
sorting content, 61
sound. See audio
source footage. See video footage
speed controls, 112. See also playback
Split Clip tool

in Sceneline view, 92–93
in Timeline view, 99–103

split editing, 214
splitting clips

in Sceneline, 92–93
in Timeline, 99–103

Stabilize filter, 130–131
stacking order, 188
standard definition. See SD
standard effects, 110, 126
star ratings, 63, 65
static masks, 147
still images, 31, 62, 112, 247–249
stop markers, 242, 243–244, 245. See also markers
stop-motion video, 51
storyboard-style editing, 14, 25, 86
strokes, 292, 296
styles

layers, 296
text, 177–178, 187, 292

submenus, 242–245
synchronization, 76–77
system requirements, 2

T

tagging, 63–78. See also keyword tags
clips in Organizer, 64–65
creating Smart Albums with, 78
described, 63
Smart Tags, 11, 68–70, 78, 220
star ratings, 63, 65

tape-based devices
capturing stop-motion from, 51
capturing video, 10, 40–47

Tasks panel
customizing, 33–34
overview, 15–18
using Transitions view in, 153–154

templates
applying, 237
disc menu, 236–239, 245, 247, 249
drop zones in, 247
replacing, 237
titles, 172, 191–192, 240

text. See also titles
alignment, 182, 291
buttons, 251–255
centering, 177, 180, 186, 189
changing menu titles/buttons, 253–255
color, 180–181, 187–188, 255
fonts, 177–179, 238, 254, 291
Horizontal Type tool, 174, 180, 291
kerning, 177–178
modifying in titles, 175–185
repositioning, 175
size, 177–179
styles, 177–178, 187, 292
superimposing over video clips, 185, 186–189
warped, 293–294

theme music, 72
themes, movie, 71–72, 218–225
Themes view, 17
Three-Way Color Corrector effect, 120–123
thumbnail scene buttons, 250–255
thumbnails, image, 239–242
Time Stretch tool, 131, 144–145
timecode, 43, 46, 70, 83, 84
Timecode control, 84
timecode-based scene detection, 43–44, 45
time-lapse video, 51
Timeline view. See also Sceneline view

adding/deleting tracks in, 95
considerations, 93
customizing track display, 96
described, 14–15
editing in, 96–99
slide shows, 101–103
Split Clip tool, 99–103
switching between views, 86
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trimming clips in, 97–99, 100
vs. Monitor panel, 83
working with My Project panel, 93–96
zoom controls in, 94, 97, 100, 296

title safe guides, 289
titles. See also text

adding images to, 182–183
animating still, 185
centering, 180
color, 180–181, 187–188
creating, 173–175
customizing in Photoshop Elements, 289–295
fade effects in, 183–184
modifying text in, 175–185
rolling credits, 189–191
superimposing over video clips, 185, 186–189
templates for, 172, 191–192
working with, 172

Titles view, 16
title-safe zones, 176, 253
tonal range, 121–123
tracks. See also audio tracks; video tracks

adding/deleting, 95
changing height of, 95
customizing view, 96
displaying, 94
enlarging, 138
horizontal, 14
stacking order, 95
using Picture-in-Picture overlay for, 141–142
vertical, 93

transitions, 150–168
accessing, 153–154
adding to multiple clips, 165–166
alignment, 159, 162
applying, 154–155, 287
audio, 16, 153
considerations, 152–153, 167–168
copying/pasting, 166
deleting, 155
deleting clips and, 90
duration of, 164, 167
experimenting with, 168
fading in/out, 138–140, 163–164
GPU-accelerated, 165
length of, 155, 158
modifying default settings, 158–161
moving clips and, 89
preferences, 155, 165, 287
previewing, 155, 158, 163, 164, 166
properties, 155–157
rendering, 165
replacing, 161–163
reversing, 159
smoothing, 163, 165, 166
video, 153, 154, 165

working with, 152–167
Transitions view, 16, 153–154
trimming clips

In/Out points, 90–91, 97
in Sceneline, 90–92, 93
in Timeline, 97–99, 100
using Smart Trim, 103–106

troubleshooting
aspect ratio, 27
Community Help, 4
correcting problems in footage, 111
curative effects, 111
device-control issues, 48–49
resources for, 4–5
settings-related issues, 27–31

TV
previewing video on, 83, 176, 233, 239
safe zones for, 176

Type tool, 174, 177, 180, 182
Type Tool button, 174

U

undo feature, 20
uploading movies/files. See also exporting

to Facebook, 269–271
to Photoshop.com, 74–77, 263, 268–269
Web DVDs, 256–257, 269
to websites, 268–269, 271
to YouTube, 266–268

USB ports, 230

V

VHS video, 52
Vibrance slider, 117
video. See also movies; projects; video footage

adding to menus, 247–250
adding to projects, 62
analog, 38, 52
black, 173–174
capturing. See capturing video
compatible formats for, 275
editing. See editing
exporting. See exporting
Flash, 266, 275
HD, 26, 130, 256, 266
importing. See importing
linking/unlinking with audio, 214
navigating in, 83–85
organizing. See Organizer
playing. See playback
previewing. See previewing
QuickTime, 271, 275, 282
resolution, 30–31, 266
scrubbing through, 84
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video (continued )
SD, 26, 114, 130, 163, 256
source footage. See video footage
stop-motion, 51
synchronizing, 76–77
time-lapse, 51
trimming linked audio and, 214
uploading. See uploading movies/files
VHS, 52
zoom controls. See zoom controls

video deck. See camcorders
video devices, 16, 45–46. See also camcorders
video effects. See also effects

deleting, 115, 126, 127
gallery of, 148
using, 110–111
viewing, 16

video files
compression, 258
importing, 38
inserting as menu background, 250

video footage. See also clips; content; video
analyzing. See Auto Analyzer
aspect ratio, 27–31, 273
capturing. See capturing video
choosing for Video Importer, 49–50
considerations, 28, 260, 266
converting analog to digital, 52
correcting shakiness of, 130–131
disk space required for, 41
editing. See editing
exporting. See exporting
grabbing frames from, 277–278
importing. See importing
indoor/outdoor shoots, 115
inputting from camcorders, 10
organizing. See organizing content
project setup, 26–27, 30
resolution. See resolution
settings for, 30–31
spacing between lines, 179
trimming. See trimming clips
types of, 38

Video Importer, 39–40, 47–52
video tracks. See also tracks

customizing view, 96
enlarging, 138
working with, 94–96

video transitions, 153, 154, 165
Video Transitions folder, 153, 154, 165
Videomerge effect, 142–144
Vintage Photo effect, 291
volume adjustments, 204–212, 215
Volume effect, 112

W

warped text, 293–294
waveforms, 207, 208–209
Web DVDs, 256–258, 260, 269
webcams, capturing video from, 16, 40, 42, 44, 45
websites

compatible formats for, 275
uploading movies to, 268–269, 271

white balance, 122
Windows Media files, 275
work area, 10, 86, 120
work area bar, 266, 268
workspaces. See also specific workspaces

customizing, 33–34
illustrated, 7
overview, 8–10

Y

YouTube movies, 266–268

Z

zoom controls
keyboard shortcuts, 94, 296
in Monitor panel, 85–86
in My Project panel, 94
in Timeline, 94, 97, 100, 296

zoom effects, 112, 132–135
Zoom In button, 94, 97, 100, 183
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